 
   
    
     
      
    
 
     
      
       
       
     
 
    
 
   
 
   
     
     
      
       
        
        Hyperlinks to XLS, DOC, and PDF files that are included in a .chm file work intermittently.
 
        
          SUMMARY

Hyperlinks to XLS, DOC, and PDF files that are included in a

.chm file (and the Baggage Files) only work intermittently. The

only solution appears to be deleting the Temporary Internet Files. 

PROBLEM

1. I place the XLS, DOC, or PDF file in the Windows

sub-directory that corresponds to the RoboHelp project sub-folder

where the topic in which I’ll place the hyperlink exists. 

2. I open the help project in RoboHelp HTML.

3. I right-click on the project’s Baggage Files

sub-folder that corresponds to the Windows sub-directory in which I

placed the XLS, DOC, or PDF file (in step 1).

4. I import the XLS, DOC, or PDF file. 

5. I open the topic in which I’m going to place the

hyperlink in the WYSIWYG editor.

6. I “drag and drop” the Baggage File into the

topic (in the WYSIWYG editor) to create a link to it.

7. I save the changes and then generate HTML (.chm) help. 

8. I open the .chm file and click the hyperlink. The XLS,

DOC, or PDF file may or may not open. 

9. When the hyperlink works correctly, for DOC and XLS files,

a “File Download – Security Warning” dialog box

appears asking, “Do you want to open or save this

file?”. The buttons that are available are

“Open”, “Save”, and “Cancel”.

These buttons work then as one would expect. (When the hyperlink

works correctly for a PDF file, it simply opens the PDF file in a

new window; there’s no prompt to save, open, or cancel.) 

10. When a hyperlink does NOT work, for DOC, XLS, and PDF

files, no dialog box or other visual message is displayed. Instead,

the sound that is associated with the “Exclamation”

program event is played (the “Windows XP

Exclamation.wav” file is the WinXP default). 

Other Notes:

- The hyperlinks ALWAYS work when I view a topic using the

“View Selected Item” function (Ctrl+W) in the RoboHelp

HTML project.

- Once a hyperlink stops working, it will not start working

again until I delete all the Temporary Internet Files.

- A hyperlink will stop working even if Internet Explorer

(iexplore.exe) is closed the entire time.

WORKAROUND

Through trial and error, I have discovered that if a

hyperlink stops working, I can get it to work again using the

following steps:

1. Leave the .chm file open.

2. Open Internet Explorer. 

3. Click Tools>Internet Options….

4. From the “Internet Options” dialog box, select

the “General” tab.

5. Under the “Temporary Internet Files” section,

click the “Delete Files…” button. 

6. From the “Delete Files” dialog box, select

“Delete all offline content” and then click

“OK”. The files are deleted and the “Delete

Files” dialog box closes.

7. Click “OK” to close the “Internet

Options” dialog box. 

8. Without closing Internet Explorer and without re-starting

the .chm file, all the hyperlinks that didn’t work before

will now work.

GENERAL SYSTEM INFORMATION

- Windows XP Pro, SP2

- Internet Explorer 6.0.2900.2180

- RoboHelp X5, 5.0.2 Build 801

- HTML (.chm) help project files exist on my local machine

- HTML (.chm) help file is run from my local machine

- Project is under RoboSource version control 

TEMPORARY INTERNET SETTINGS

- “Check for newer versions of stored pages” is

set to “Automatically”

- “Current location” for the Temporary Internet

files folder is set to “C:\Documents and Settings\My

Username\Local Settings\Temporary Internet Files\”

- “Amount of disk space to use” is set to

“594” MB

“View Files…”

- An XLS or DOC file will be listed here if I click its

hyperlink and then click either “Open” or

“Save” from the “File Download – Security

Warning” dialog box. 

- A file will appear here even if I click “Save”

and then click “Cancel” from the subsequent “Save

As” dialog box. 

- If I click “Cancel” from the “File

Download – Security Warning” dialog box, the file does

not appear in the Temporary Internet Files folder. 

- When a file does appear in the Temporary Internet Files

folder, its Internet Address is displayed similar to the following:

“ms-its:C:\PrimaryProjectFolder\ProjectName.chm::/SubFolderName/FileName.xls”

“View Objects…” 

Here’s a list of all the program files that appear:

- “Microsoft Office Template and Media Control”

(Last Accessed 12/13/06) (Version 12,0,6024,0)

- “Shockwave ActiveX Control” (Last Accessed

12/14/06) (Version 10,1,4,20)

- “Shockwave Flash Object” (Last Accessed

12/18/06) (Version 9,0,28,0)

- “Windows Genuine Advantage Validation Tool”

(Last Accessed 12/14/06) (Version 1,5,722,0) 

- “WUWebControl Class” (Last Accessed 12/13/06)

(Version 5,8,0,2469)

Today is 12/18/06 so the only program file that is listed as

having been “Last Accessed” today is the

“Shockwave Flash Object”. 

REQUEST FOR HELP

I really want to include certain PDF, DOC, and XLS files in

their native format in a .chm file. However, I need a better

solution to my problem than the one I discovered. What I really

want is to avoid the entire problem altogether. 

Have anyone seen this before or have any suggestions? 
        
 

         
         You wont be able to do that. The embedded objects would appear as images only.
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          Similar Messages
 
          
 
           	 
		     How to list files that are NOT in a .jar file?
 
			 Is it possible to list files (resources, .gif/.jpg files, etc.) that are NOT included in the jar but are still to be considered part of the application somewhere in the jnlp-file?
 My applications requires lots of icons which I have put into .gif files. So far I kept them in individual files next to the .jar file and that worked fine. 
 JWS now seems to support only stuff that is included in (a) .jar-file(s). That in itself woul not be much of a problem, however, when I include my .gif files into the .jar files they seem to get corrupted by the jar-signing process (at least that what's the code says, which can suddenly not handle these images any more).
 
			 My previous seem to have been non-sense. The .gif file were not corrupted, but rather they were not found at all. They actually must NOT be included in the .jar file, or else they are not found. Strange enough, the .properties-file seemingly HAS to be in the .jar file to be found.

This is something I'll probably never fully understand with java: which file-types it searches where...
 
		   

 
           	 
		     My macbook pro inform that i am running out of disk space. However, I am unable to secure delete those files that are in Trash. Many files in Trash are "locked". how do I secure delete these files in trash
 
			 I am unable to secure delete those files in the Trash. Many files are marked as "locked" Is this way I cannot secure delete these files?
 
			 Can you not just select them and remove the locked flag?
 
		   

 
           	 
		     I have nine, 1-page PDF files that are accessible and need to combine into 1 PDF file.  I have tried appending, adding and the combine PDFs process. The file created is not keeping my changes. The created file is partially accessible but I have to re-fix
 
			 I have nine, 1-page PDF files that are accessible and need to combine into 1 PDF file.  I have tried appending, adding and the combine PDFs process. The file created is not keeping my changes. The created file is partially accessible but I have to re-fix issues I had fixed in the single files. I need suggestions on what else can be done if any. Using Acrobat pro XI.
 
			 Out of habit, I tend to combine PDF files in the Page Thumbnails pane by right-click then "Insert Pages" -> "From File". For me, this preserves the tags from both documents, although the tags may have to be moved into the right location (if I recall correctly the tags for the inserted pages get put at the end of the tag structure, regardless of where the pages are inserted), If I first put the tags for the document to be inserted inside a container tag like Section, it makes the process easier. Moving that set of tags to the right place is the only re-fixing that I recall having to do. What behavior are you experiencing?

a 'C' student
 
		   

 
           	 
		     Uploading .doc and .pdf files from iPad
 
			 Is there any such free app in App Store to upload .doc and .pdf files from my iPad mini to Internet? 
 I usually upload my Resume on different job portals, but it is not possible from Safari or Chrome browsers on my iPad mini, I have to do it from my PC every time just to upload a single file. Looking for a solution to this reported issue.
 Thank you..
 
			 There is no native ability to upload files other than photos and videos using the built in Safari browser.

Look into iCab Mobile for file uploads to websites.  Its not free though, and I'm not aware of a free alternative at this point. 

https://itunes.apple.com/en/app/icab-mobile-web-browser/id308111628?mt=8

You will need to transfer the file to iCab to be able to upload it though.
 
		   

 
           	 
		     One workflow to join docs and pdfs to one big pdf
 
			 Hi! I've been trying to do something that, until now, just hasn't worked.
 I have a bunch of word docs in a folder and I want to convert them to pdf and join them together. I have no problem with that. But, can I use the same workflow to join pdfs together that were not word docs to begin with? An action to "ignore the conversion" if the file is already a pdf.
 Furthermore, can I grab a bunch of docs and pdfs and join them in one giant pdf so that the docs will be converted and then the multiple pdfs joined with just one workflow?
 If so, how?
 Thank you very much.
 
			 I am having the same issue, I have tried repairing the installation and it did not work, I have uninstalled and then reinstalled and still no right click options. I have 3 computers with this issue and each of them when you right click will not show any of the acrobat options, but they do have a blank line (no text) that when clicked will open the combine window. Any help or suggestions would be greatly appreciated!
 
		   

 
           	 
		     I cannot open any pdf files that are saved to my computer. Keep getting error 507:507
 
			 Every time I try to open a pdf file from a website or through an email it will not let me opne the file. I can open files that are saved to my computer but that doesn't do me much good in some scenarios. I run IE 10 on Windows 7 Home with Adobe Reader XI 11.0.04. I have tried unsinstalling and reinstalling. It works fine for a few days then the errors start again. HELP!
 
			 Thank you Pat!!!

Craig Ekonomos

[email address removed]
 
		   

 
           	 
		     I cannot ope PDF files that are within a web link.  Neither Safari nor Firefox will work.  If I receive a PDF file as an email attachment, I can open it with either Adobe or Preview.  I'm running 10.6.8 on an iMac.
 
			 I'm going to re-state this.  Several weeks ago, I had installed Security Update 2012-004 on my iMac.  I'm running Snow Leopard 10.6.8.  Immediately afterwards, my Mail 4.6 was GONE.  Mail 4.2 was there, but the system would not open it.  The Apple Support Communites quickly solved my problem.  The problem lay within the Update.  Now, I cannot open PDF files that are contained within a website, i.e. a lunch menu that is on a restaurant website.  This happens on both Safari and Firefox.  If someone sends me an email with an attached PDF file, I can open the file with either Adobe or Preview.  This is happening only on my iMac.  My MacBook Pro, also running Snow Leopard 10.6.8 has not experienced either the first or second problem.  Thanks for any help you can offer.
 
			 fomamac2guy wrote:

Now, I cannot open PDF files that are contained within a website, i.e. a lunch menu that is on a restaurant website.

Does this help with Firefox?
 
		   

 
           	 
		     After downloading the latest upgrade of Adobe, I can no longer open files that are PDF's.  Why do I keep getting error 0.104?
 
			 Since October 23rd, after downloading the recent upgrade for Adobe Reader,  I continually keep getting error code 0.104 whenever I try to open a file that is in PDF format.  No matter if I'm using Internet Explorer or Chrome.  Huge waste of time!  I have restored the Adobe to previous upgrade of September 2014, which was working fine.  I have restarted the computer several times since I restored to prior version with no luck at all.  
 
			 This is the message i keep getting when I try and open my PDF files that are on my desktop. I run a Macbook Pro. I checked for updates on system and adobe all say unto date?

Adobe Reader could not open 'Employment Application(1).pdf' because it is either not a supported file type or because the file has been damaged (for example, it was sent as an email attachment and wasn't correctly decoded).
 
		   

 
           	 
		     Why doesn't my pdf files that are on my iPad show up on my iMac or mac book pro
 
			 Why doesn't my pdf files that are on my ipad show up on my imac or macbook?
 
			 Have you copied them from your iPad ? If you are using the 'sync collections' setting then that doesn't copy items between devices/computers, all it does is if you move a book/PDF into a collection on one device/computer then if that book/PDF is also on your other device(s)/computer(s) then it will be moved into the same collection on them.

If you connect the iPad to the computer that you sync it to and do File > Devices > Transfer Purchases then it should copy them over to your Mac's iTunes (that should copy PDFs and epubs that are in the iBooks app, not just actual ibooks) - in the iBooks app on your Mac you might then need to do File > Move Books From iTunes to move them over to it.
 
		   

 
           	 
		     Why can't I open/see PDF files that are embedded in an email or sent through the internet?
 
			 I can read/see PDF files that are attached to an email, but I can't see/read them if they are embedded in an email or sent through the internet.
 
			 I have a similar problem. I can open, read, and save PDF files, but I can't view my online bank statement on my Mac. The statement opens automatically if I use a PC, but on my Mac the page says I need Adobe Reader to view my statement. I already have the latest version of Adobe Reader. The problem seems to be that that the plugin only goes to the Libray. It doesn't get installed into Safari or into FireFox either.
 
		   

 
           	 
		     SAFARI 6.1.3 update to Reader 11.0.07 - cannot open pdf files that are presently on my computer. Previous version had no problem. Any ideas?
 
			 SAFARI 6.1.3 update to Reader 11.0.07 … cannot open pdf files that are presently on my computer. Previous version had no problem. Any ideas? (Here is the message: Adobe Reader could not open 'Digital_Holiday_Cookbook.pdf' because it is either not a supported file type or because the file has been damaged (for example, it was sent as an email attachment and wasn't correctly decoded).
 
			 Thank you Pat!!!

Craig Ekonomos

[email address removed]
 
		   

 
           	 
		     Work text prog for .doc and .pdf
 
			 hey,
 i have written a program to calculate word frequency from the text file,
 can any one tell me how can i make this program work for .doc and .pdf file.
 i dont want to use POI for .doc.
 
			 There is no need to start a new thread. Stay in your [original thread|http://forums.sun.com/thread.jspa?threadID=5363365] . 

I'm locking this one.
 
		   

 
           	 
		     I have 91 file that are pdfs i need to make searchable what is the best way of doing this
 
			 help
 i have 91 file that are pdfs i need to make searchable what is the best way of doing this
 
			 Hi ismaelr61128862,

I would recommend you to try Advanced search option of Acrobat software, Go to Edit and then Advanced search.

Hope that helps.  In case you have any further questions please provide sufficient amount of details so that i can assist you more accurately.

Regards,

Rahul
 
		   

 
           	 
		     HT1351 Whether or not I sync items on iTunes to my ipod, I cannot eject the ipod because a message keeps coming up and saying that my ipod cannot be ejected because it contains files that are being used by another application. How do I fix this?
 
			 I just got an ipod classic 7th generation a couple days ago and I'm having a heck of a time with it. My latest problem is that with media on iTunes, I cannot eject the ipod because it says that it cannot be ejected because it contains files that are being used by another application. What application is this, and what do I do about it?
 
			 Hi newipoduser,

Here are some possible solutions:

Do you use musicmatch jukebox on your computer? If you do, you have to go into task manager on windows and end process mim.exe. It interferes with disconnecting ext devices

Empty your "trash/recycle bin."

If that doesn't work, try quitting all your programs, especially music-type programs, basically things that look for mp3's etc.

if that doesn't work, "log off" then "log on" and that should refresh/purge your OS system.

Finally, you can restart your computer.

Hope one of these helps!

Cheers,

GB
 
		   

 
         
 
        
 
		 
          Maybe you are looking for
 
          	 
		     Block  invoices from open item clearing F-32
 
			 Dear folks, We have a requirement where blocked customer invoices (blocked for payment), should not be: 1) available for posting payments in F-28. 2) available for open item clearing down payments in F-32. The first one is achievable through "Release
 
		   
	 
		     Pages, recent items not working
 
			 OS 10.7.5, Pages 4.2 Recent Items do not show recent items. Anyone else?
 
		   
	 
		     What to do with iTunes when you get another iPod?
 
			 My daughter has an iPod mini that is completely filled up. For her birthday, she want to get a new 30G iPod. The thing I am wondering about it whether or not she will be able to use her current iTunes library with the new iPod. I would not want to se
 
		   
	 
		     Add/Remove instance manager issues
 
			 My add instance button is working as intended. The remove instance button is working, but not as I would like it to. The instance it removes is not necessarily the last instance added, as I would like. When "clicked" it removes the second instance li
 
		   
	 
		     SLD Consolidation
 
			 Currently I have two seperate SLD servers (one for DEV/QAS and one for PRD).  I am looking into installing NWDI and would like to consolidate these into ONE SLD server.  If I do an export of the CIM data from the DEV/QAS system and import it into the
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